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Introduction 

The Project Manager's Guide to Project Web App provides detailed information about how to use Project 

Web App (PWA) to work with Microsoft Project Server 2010 data and to perform project 

management-related tasks. This guide helps project managers in your organization to better 

understand elements of project management in PWA, such as the following: 

 Projects 

 Resources 

 Status updates and approvals 

 Project issues, risks, and documents 

 Notifications and alerts sent to project members 

See the table of contents for a complete listing of the subjects covered in this guide. 

Important: Although Project Professional 2010 can be used with Project Server 2010 to perform many project 

management tasks, this guide only covers procedures done through PWA.   

Send us your feedback (projdocs@microsoft.com). Please let us know what you think about the 

quality of this content. If this does not meet your needs, let us know how to we can improve it. If 

this text was helpful, let us know how it helped. 

Who should read this book?  
This book is designed to provide maximum benefits for the following professionals: 

Project Managers 

Those individuals in your organization who create and maintain projects and tasks, assign 

resources to tasks, manage approvals for task status and timesheet updates, and configure 

notifications for project team members 

Project Management Office (PMO) 

Those individuals who help to define and maintain project management standards and practices 

throughout the organization  

Microsoft Project Server 2010 Administrator's Guide  
If you are looking for Project Server 2010 administrative guidance in a role-guide format that is 

similar to this guide, we also have available the Microsoft Project Server 2010 Administrator's Guide.  That 

guide describes tasks that are involved with administering Project Server 2010.  It provides many 

mailto:projdocs@microsoft.com


Introduction 

6 
 

step-by-step procedures (and accompanying user-interface screenshots) about how to manage Project 

Server 2010 through the Project Web App Server Settings page. 

You can download the Microsoft Project Server 2010 Administrator's Guide in .docx, .pdf, or .xps format 

from the Microsoft Project Server 2010 Administrators Guide article in the Microsoft TechNet 

library (http://technet.microsoft.com/en-us/library/gg663916.aspx). 

Revision History  
The following table provides the revision history of this document. 

 

  
Date  Revision  

December 2011  • Initial Publication.  

 

http://technet.microsoft.com/en-us/library/gg663916.aspx
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1 
Navigating Project Web App  

Microsoft Project Web App (PWA) is a web-based application that together with Microsoft Project 

Professional enables collaborative planning, task updates, issue tracking, risk tracking, and document 

sharing among workgroup members, Project Managers, and other stakeholders.  It is important that 

Project Managers first understand the options available to both themselves and to PWA users.  

When you log on to Project Web App, you first see your personalized Microsoft Project Web App 

home page.  This page provides summary information about items assigned to you, plus links to help 

you navigate throughout the PWA web site.  
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The home page provides a Quick Launch that you can use to navigate to information such as My 
Work, Projects, Resources, and others. Access to these system features is dependent on the security 
model and the role that you have been assigned to. Contact the Project Server administrator if there 
is a function, such as Project Center, that you should be seeing and you are not able to. 

The Project Center provides a convenient way for project managers, team members, and other 
project stakeholders to view detailed information about individual projects and to view summary 
information about portfolios of projects. Users who have permission to access the Project Center in 
Microsoft Project Web App or Microsoft Project Professional 2010 can use the Project Center to 
work with any project or portfolio of projects to which they are assigned. Only projects that are 
published to the Microsoft Project Server 2010 database are available in the Project Center. 

The following table lists the Microsoft Project Server 2010 permissions that are required in order for 
Microsoft Project Professional 2010 and Microsoft Project Web App users to work with the Project 
Center. 
Permission 

Type 

Permission Description 

Category Save Project Allows a user to save projects to the Project 

Server database from Project Professional 

Category Open Project Allows users to open and edit their project in 

the project schedule view in Project Web App 

Category Publish Project Allows the user to publish the project plan 

Category Save Project to Project Server Allows the user to save the project schedule to 

the Project Server 

Category View Projects Summary in 

Project Center 

Allows a user to view projects and project data 

that is stored in Project Center 

Category View Projects Schedule in 

Project Web App 

Determines the list of projects (and 

corresponding project details) that are available 

in the Project Center 

Global Log on to Project Server from 

Project Professional 

Allows a user to load the Enterprise Global 

Template when connecting Project 

Professional to Project Server 

Global New Project Allows a user to add a new project to Project 

Server by using Project Professional, Project 

Web App or the Project Server Interface (PSI) 

Global View Approvals Allows a user to view the Approval center in 

Project Web App 

Global View Project Center Allows a user to access the Project Center 

from Project Web App or Project Professional 

Global View Project Schedule View Allows a user to access and view project details 

in the Project Center 

Global Manage Check-Ins Allows a user to check in projects by using the 

"Check in my projects" link in the Project 

Center 
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Get oriented 
 

 
 

The Project Web App interface is made up of three main areas: 

 Quick Launch  

 Ribbon 

 Content display area 
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The Quick Launch area 
 

 

The Quick Launch, on the left side of the window, lists the main views and pages that you are able to 

access. You can click these links to navigate to different areas of the program. Some pages in Project 

Web App do not include the Quick Launch. For example, when you fill out a form, you must 

complete and save the form or cancel out of it, in order to return to the Quick Launch. 

The ribbon area 
Project Server 2010 utilizes the ribbon interface, which provides a familiar and consistent navigation 

experience.  The ribbon is the toolbar that you use to perform actions on the project information in 

the content display area. The ribbon replaces the previous navigation design that consisted of menus 

and toolbar drop-down lists.  This is the same navigation ribbon approach used in all Microsoft 

Office 2010 applications. There may be multiple tabs on the ribbon, to change between different sets 

of actions. Each tab contains groups of related buttons that you can use to interact with the page 

content. 

For example, the Project Center enables viewing and actions to the summary level project plan. It 

uses multiple ribbon tabs, based on the actions you are taking within the Project Center. 

The Projects details tab on the ribbon has multiple parts depending on whether the action involves 

viewing or modifying project information or the project plan schedule.   
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The Task tab, under Schedule Tools on the ribbon, allows project managers to edit the project 

schedule in PWA.  

 
 

The Options tab, under Schedule Tools on the ribbon, has additional functionality for viewing the 

project schedule details and linking information to the project site. 

 

The content display area 

 

The content display area contains information about your portfolios, projects, and tasks. This is the 

main focus of each page, and it is where you enter and review data. 

Key areas 
Project Web App is highly customizable, so your organization can have a unique starting page. By 

default, the main page that appears when you open Project Web App is a great starting point. It 

shows information about tasks, timesheets, approvals, status reports, issues, and risks. 

There are other useful places to start in Project Web App, depending on what you intend to do while 

you are logged on. From a project manager perspective, the following are the key areas. 
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Create projects and schedule tasks 
In Project Web App, you can create projects and schedule tasks in the Project Center. On the Quick 

Launch, under Projects, click Project Center. On the ribbon, click the Projects tab to access the 

tools you can use in the Project Center. Here, you can create new projects by using templates or by 

importing SharePoint lists. On the Projects tab of the ribbon, click the arrow on the New button. 

Use the list that appears to choose which method you want to use to create a new project. 

Once you have created a project, you can use the tools on the Project, Task, and Options tabs of the 

ribbon to work with the project's tasks. 

Work with resources 
With a project and its tasks in place, the next step is to assign the resources that will complete the 

tasks. In some organizations, a resource manager may be responsible for assigning resources to tasks, 

but typically this falls on the project manager's plate. In Project Web App, you can add resources and 

manage your enterprise resource pool in the Resource Center. On the Quick Launch, under 

Resources, click Resource Center.  

Once the resources you need for the tasks in your project are added to the Resource Center, you can 

assign them to tasks by using the Project Center. On the Quick Launch, under Projects, click Project 

Center. Click the name of your project in the list to open it for viewing, check the project out for 

editing, and then build your team. Pick resources from your team to assign to tasks in your project. 

Track time and task progress 
Some project managers may find time and task progress tracking crucial for monitoring project 

status. As a project progresses, team members assigned to project tasks report how much time they 

spend on tasks and how much work is left. As the manager of the project where this data is being 

reported, it is your responsibility to review and approve or reject this time and task progress as it is 

reported. 

The Approval Center provides a central location for approving both time and task progress. On the 

Quick Launch, under Projects, click Approval Center. Here, you can review the data that has been 

reported by team members, and then either approve the data, submitting it to the project, or reject it, 

with notes to help communicate the reason for the rejection.  

 
  



   

13 
 

2 
Managing projects in Project Web App 

Managing projects through Project Web App (PWA) is a key responsibility of a project manager. 

This chapter describes procedures a project manager does when managing projects through PWA, 

including the following:  

 Creating a new project 

 Viewing and opening a project  

 Checking in a project using the Forced Check-in feature 

 Setting up permissions to project  

 Editing custom fields 

 Changing ownership of a project 

 Exporting Project Center data to Microsoft Excel 

 Modifying a project plan 

Using the ribbon to manage projects 
The Project Center enables viewing and actions to the summary level project plan. It uses multiple 

ribbon tabs, based on the actions you are taking within the Project Center.  

The Projects details tab on the ribbon has multiple parts depending on whether the action involves 

viewing or modifying project information or the project plan schedule.  

 
 

The Task tab, under Schedule Tools on the ribbon, allows project managers to edit the project 

schedule in PWA.  

 
 

The Options tab, under Schedule Tools on the ribbon, has additional functionality for viewing the 

project schedule details and linking information to the project site. 
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The Project tab on the ribbon shows different options when the project is in edit mode.  It allows 

project information to be modified. 

 

The Permissions tab on the ribbon is available when a project in the Project Center is selected and 

the Project Permissions button is clicked.  This allows a user with the proper project permissions, 

generally the project manager, to assign rights for the project and project site to individual users or 

groups not on the project team. 

 

About the Project Center 
The Project Center lists all of the projects that are saved and published to the Project Server database 

that the current user has permission to view. The default view, Summary, lists basic data about the 

projects. Other views of project data are also available and custom views can also be created. 

In the Project Center, you can do the following: 

 View a portfolio of projects or individual projects. You can see summary information about 

multiple projects or detailed information about individual projects. 

 Project information can be viewed in a detailed or high-level timescale with the ability to apply 

filters and grouping to different views.  

 Open a project plan in edit or read-only mode in Project Professional or PWA. 

 Update the project with a SharePoint task list. 

 Build a project team from the enterprise resource pool based on the skill levels required for your 

project and resource availability. 

 Establish a resource plan associated with a project.  A resource plan allows you to plan for 

resource allocation without requiring you to have specific assignments. 

 Set project permissions for individual resources or groups to view or edit your project.  

 Check in checked-out projects.  

 Close specific tasks in a project to no longer allow updates by team members. 

 Project summary and detail information visible in the Project Center view to the left of the Gantt 

chart can be exported to Microsoft Excel or printed.  

 Access the project site for your individual project, including creating a discussion board, creating 

a list of related files and documents, creating and updating issues and risks, and setting up a 

document library. 
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 Show or hide subprojects. 

 Update the enterprise project type associated with the project. 

You can group and sort the list of Projects to view various types of rolled-up data about any project 

that you can view, or you can view detailed information about a particular project without opening 

Project Professional 2010. You can create, modify and assign resources to a project schedule in the 

Project Center.  Additionally, specific functions for particular projects can be performed as well; for 

example, a project manager can check in a project that was not checked in properly or an executive 

can view information about a group of projects. 

Creating new projects in PWA 
You can initiate new project schedules in PWA. You now have the ability to begin your project with 

a blank project plan or an enterprise template that uses project types in Project Server. 

Note:  It is important to understand that creating a project from a template in PWA includes not only the 

project schedule template but also the project workspace template.  So if your organization uses different 

project workspace templates, you should create your project schedule in PWA to make sure that you have the 

correct project schedule template and workspace template. 

To create a new project schedule: 

1. In PWA, select Project Center in the Quick Launch. 

 

2. In the Project Center, on the Projects tab of the ribbon, select New. This opens a drop-down 

list to allow the creation of a new project schedule.  Select the appropriate project plan. 

 

3. A Project Details or Project Information web page appears with project fields to be filled out. 

Enter the related project information in the fields, and then select Save. 
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Note:  Any field name with a red asterisk “*” next to it is a REQUIRED field and must be filled out in 

order for the project to be saved. 

 

The project information is saved and PWA opens the Schedule web page.  To move between the 

Project Information/Project Details page and Schedule page, click the link in the left navigation 

column.  

 

4. With the Schedule page open, select the Save button on the ribbon. 

 

A yellow message box appears in the top right corner of the project schedule, indicating the 

status of the save operation.  After the project has been saved to the database, this message will 

appear: 

 

5. It is important to note that at this point the project plan is saved in the Project Server 2010 

draft/working database.  It is not visible to others in the PWA Project Center until the project 

plan has been published.  If it is necessary for others to see the plan immediately, select the 

Publish button in the Schedule Tools tab of the ribbon.   
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After the project has been published, a verification message in yellow appears in the top right 

corner of the project schedule: 

 

6. When you are finished setting up the project plan and have successfully saved and published it, it 

is time to check in the project plan.  Select the Project tab, and then click the Close button.  

This ensures that you can modify the project plan in either PWA or Project Professional. 

 

The Close window appears. Select Yes to check in the project plan. 

 

Viewing and opening projects 
You can manage your projects from the Project Center, including tracking associated risks, issues, 

and documents; linking to the Project Workspace; analyzing and modeling projects; creating to-do 

lists; and managing Administrative Projects. In addition, you can open projects in Project 

Professional directly from the Project Center in Project Web App. 

Note:  Information and access to specific features is controlled by a set of permissions that a Project Server 

administrator manages in Project Web App. 

Viewing projects 
You can view project data that is published to the Project Server database by using the Project Center 

in Project Web App. 

To view project data: 

1. To view project data, log on to Project Web App. On the Project Web App Home page, click 

Project Center in Quick Launch. The Project Center displays all of the projects that you have 

permission to view. 
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2. A number of viewing options are available on this page. To change the view that is showing, use 

the View drop-down list to select a view. 

 

3. To open the detail view for any project, click the project name. It may be necessary to select the 

Schedule link in the left navigation column to see the project plan. 

 

This view is similar to the view in Project Professional, and the project tasks can be edited in 

Project Web App by selecting the Edit button in the Schedule Tools, Task tab.  This reflects 

the most recent publication of the project to the Project Server. 
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A number of different views at the task level are available in Project Web App. To switch views, 

use the View drop-down list on the Data tab of the ribbon to select a view. For example, you 

can select a Resources Work view. 

 

The views that are available in the View list are customizable. A Project Server administrator can 

create custom task, resource, and project views by using the Manage Views section of the 

Server Settings page in Project Web App (PWA). 

Using the Filter and Group By options in the Project Center 

You can use the Filter and Group By drop-down lists to customize how you want to sort and group 

projects. The Filter and Group By features are useful when the Project Center includes a large 

number of projects. This feature includes the following options: 

 Filter: Allows you to filter projects by using a custom filter. 
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You can use a custom filter by selecting Custom filter from the Filter drop-down list and 

defining the custom filter to be used. 

 

You can also choose to auto-filter tasks by selecting the down arrow to the right of the column 

heading.  

 

 Group By: Allows you to group projects by specified values. In the Group By drop-down list, 

either select a single grouping from the available list, which is all of the columns active in the 

view, or create a custom grouping parameter in the Group by drop-down list.  When creating a 

custom grouping it is possible to set an additional grouping parameter from the Then by drop-

down list. The second parameter filters data within the data filtered by first parameter.  To 

remove grouping, select the No Group option in the Group By drop-down list. 
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Opening projects 
You can open projects directly in Microsoft Project Professional 2010 from the Project Center in 

PWA as long as all projects that you open from PWA are of the same type (either enterprise or non-

enterprise). If you select ten or more projects, you have the option to open them all as either read-

only or read/write. 

In PWA, click the Project Center link in the Quick Launch to open the Project Center. Highlight the 

project plan you want to open.  Select the manner in which you want to open the project from the 

Open drop-down list. 

 

Note:  If you open multiple projects, the projects open in Project Professional as a consolidated master project. 

The project opens in Project Professional 2010. 



Managing projects in Project Web App 

22 
 

 

Opening projects as master projects 

Use the Open feature in PWA to open two or more projects in Microsoft Project Professional 2010 

from the Project Center in Project Web App as a master (consolidated) project. You can select 

projects individually in the Project Center or select them as a group by using the group header in the 

Project Center. If ten or more projects are to be consolidated into a master project in Project 

Professional 2010, you have the option to open them in a consolidated master project as read-only or 

as read/write. 

When you are working with master projects by opening them from the Project Center, note the 

following: 

 You can open any number of projects as a master project, but if you attempt to open ten or 

more projects you have to select whether you want to open them all as Read/Write or Read 

Only. Depending on the size of the selected projects, this action can take a significant amount of 

time. If you select Read/Write, you are able to make changes to the projects and the projects are 

checked out to you. If you select Read Only, you are be able to view the projects and associated 

reports, but not make changes, and the projects are not checked out. 

 You can save a master project if you want to refer to it frequently. If you save a master project to 

the Project Server database, give the project a name that other project managers, resource 

managers, and team members can clearly identify.  By clicking the master plan name in the 

Project Center, you can view the subproject details in Project Web App.   

 To show subprojects in the list of projects visible in the Project Center, in the Projects ribbon, 

select the check box for Subprojects. 
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Note:  Only enterprise or non-enterprise projects can be consolidated into Project Professional 2010 as a 

master project by means of the Open Project feature. You cannot create master projects that consist of both 

enterprise and non-enterprise projects. 

Open a master project in Project Professional 2010 

In the Project Center in Project Web App, select the projects you want to open in a master schedule. 

You can select how you want to open them in the Open drop-down list. 

Select two or more projects in the Project Center. You can also select a group of projects by using an 

Enterprise Project Outline Code heading in the Project Center. 

The projects open in Microsoft Project Professional 2010 as a consolidated project. If any of the 

projects are checked out to another project manager at the time that you attempt to open the 

consolidated project, those projects will only be available as read-only projects in Project Professional 

2010. 

Forced check-in of a project 
You might need to force a check-in of a project if a project has been left checked out. For example, 

this could happen if your connection to Project Server 2010 is interrupted while a project is open or 

if Project Professional is closed abruptly before you can check in a project. If a project is left checked 

out, it appears as checked out in the Open from Microsoft Project Server dialog box. You can 

force a check-in of your own projects by using the Check in my projects link in the Project Center. 

 

You must be granted the Check In My Projects permission to check in projects in Project Web 

App. You can use this feature only to check in projects that you checked out; you cannot check in a 

project that is checked-out to any other user. (Only a Project Server administrator can check in a 

project that is checked out to any user.) 

To force a check-in of a project that you have checked out: 

1. In the Project Center in Project Web App, in the Projects tab, click Check in my projects. 

2. Select the project that you want to check in and click Check-In. 

Note:  If the project is still open in Project Professional 2010, an alert is displayed that indicates the project is 

no longer checked out and asking you to either close the project (click OK) or save the project locally (click 

Cancel, then save locally). 
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Set up project permissions in PWA 
This is a feature in PWA which allows a project manager with access to a specific project to grant 

groups or individual users access to a plan and/or project site.  This access is generally granted to 

users/groups that are not a part of the project team, unless it is granted to allow the team member to 

act as a backup who updates the project plan for the project manager. 

After setting up the project plan, return to the Project Center to make sure stakeholders and 

management have visibility into the project information.   

To set up permissions to a project: 

1. Select Project Center quick link, click the cell to the right of the project plan name, and then 

select the Project Permissions button. 

 

2. Click the New button to add a user or group to the project permissions. 

 

The resource pool is too large for the application to return all resources in a list.  Enter the name 

(first or last) in the Name field and click the Filter button. 

 

Select the permissions that you want the user or group to have for the project plan and select 

Save. 
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Note:  We recommend that a minimum of the last three permissions be granted to Stakeholders and 

Management for the project. 

3. The user/group and permissions granted for the project are listed.  Review the information to 

make sure that it is correct, and then select the Close button. As additional users that are not 

part of the project team need access, the project manager has the ability to define the level of 

access that he or she gives to the individual user or group. 

 

 

Editing custom fields 
You can edit or modify your project's information in the Enterprise Project Custom Fields by 

opening the project details view in the Project Center in Project Web App. The enterprise custom 

fields can also be modified directly in Microsoft Project Professional 2010. 

To edit a custom field: 

1. In the Project Center in Project Web App, click the name of the project plan you want to open. 

Select the Project Details view in the Quick Launch. 

 

2. Click the Edit button. 
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3. Modify the information in the custom fields that need to be update or changed.  Select Save and 

then Close to check in the project.  Once you close the project, you are returned to the Project 

Center. 

 

 

Changing ownership of a project 
The member of your organization who first saves and publishes a project to the Project Server 

database is assigned as the owner of that project. You can later change the owner of a project by 

using Microsoft Project Web App. 

To change ownership of a project: 

1. As the current owner, navigate to the Project Center in Project Web App, open the Project 

Details view by clicking on the project plan name.   

2. In the Quick Launch, select Project Details. 

 

3. On the Project Details page, select the Edit button. In the Owner field, click the Browse 

button and find the user to whom you want to transfer ownership of the project. 

When you are finished editing project details, click the Save button and then the Close button, 

and confirm that you want to Check In the project. 

4. The new owner will have to open and publish the project. 

Exporting Project Center data to Excel 
You can export project data to Microsoft Excel 2010 from Project Web App by using the Export to 

Excel button. Project Web App also enables you to copy data that is displayed in the Project Web 

App Grid Control and paste it into applications such as Microsoft Excel, Microsoft Word, or 

Microsoft Access 2010. 
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Note:  The Project Web App project view has two sections: Project Web App grid data on the left and timesheet 

data on the right. You have to copy and paste both sections and then align them in the application in which 

you have pasted the data. 

To export Project Center data to Microsoft Excel: 

1. In the Project Center in Project Web App, below the grid control, click the Export to Excel 

button. 

  

2. A file download window will appear. Select Open. 

 

3. The Project Center view opens in Excel. 

 

4. An Excel message might appear to ask you to verify the file extension. Click Yes. 

 

5. Click Save As on the File menu from Excel if you want to save the data as it is currently 

presented. You can save the data in any supported Microsoft Excel format. 

Note:  You can also export grid data to Excel by using the Print Grid feature. 
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Modifying project plans in PWA 
Project Server 2010 enables the creation and modification of complex schedules online and assigning 

multiple resources to each task. The ribbon interface provides a familiar and consistent navigation 

experience regardless of whether the project manager builds the schedule on a desktop or on the 

web.   

To modify a project schedule in PWA: 

1. Open Internet Explorer, and then type the URL. 

2. The Project Web App (PWA) homepage opens. Select Project Center in the Quick Launch. 

3. Locate the project plan, and then click the hyperlink that is the project plan name.  The project 

plan details open.   

 

Select the Schedule link in the Quick Launch.  The project plan schedule details appear. Click 

the Edit button to modify the project plan. 

 

 
 

4. Click in the bottom Task Name cell in the  row to add additional rows to the project plan.  

Click the Mode drop-down arrow to select Auto Schedule or Manually Schedule for the task 

mode.  Enter the task information.  Press the Enter key again to create another new task row.   
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Note: You can change the information shown with the task name by using the View drop-down list in 

the Schedule Tools Task tab. 

 

5. Select the Save button on the ribbon. 

 

A yellow message box appears in the upper-right corner of the project schedule, indicating the 

status of the save operation.   

After the project has been saved to the database, this message appears: 

 

At this point the project plan is saved in the Project Server 2010 draft/working database.  It is 

not visible to others in the PWA Project Center until the project plan has been Published.  If it is 

necessary for others to see the plan immediately, select the Publish button on the Schedule 

Tools tab on the ribbon.  
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After the project has been published, a verification message in yellow appears in the upper-right 

corner of the project schedule. 

 

Adding resources to a project plan 

In order to assign resources to tasks in the project, it is necessary to create a project team.  Enterprise 

resources can be added to a project team through both PWA and Project Professional by using the 

Build Team from Enterprise feature. 

1. After publishing the project plan, select the Project tab, and then click the Build Team button. 

 

2. A large number of resources are shown when Build Team feature opens.  To quickly locate the 

resources needed, apply a Custom Filter.  Select the Filter drop-down list and click Custom 

Filter.  Apply a filter. The example shown filters for Resource Names that begin with “Scott”.    

 

 

 

3. When the filter is applied, select the resource you want, and then click the Add button.  The 

resource name is added to the project team list in the right column.  Click the Save & Close 

button to save the changes and return to edit mode in Project Center. 
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4. In the Project Center edit mode, assign resources to tasks, update task-level custom field 

information and set up the duration and start date.  Note that it is now possible in PWA to 

assign multiple resources to a single task. However, the unit assignment for the resources is 

100% on the task. 

 
 

Note:  After modifying duration, percent complete, link/unlink tasks, and start or finish dates, it is 

necessary to click the Calculate button for many of the changes to be reflected. 

5. You can set up tasks and create project logic by establishing dependencies, insert new tasks, 

delete tasks, mark percent complete on tasks, and adjust the indentation level of tasks by using 

the icons in the Schedule Tools, Task tab on the ribbon.  These features behave the same in 

PWA as in Project Professional. 
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6. After setting up tasks and creating scheduling logic, select the Calculate button to ensure that all 

changes are reflected in the task data.  Once the project plan is set up, select the Save button and 

then the Publish button.   

Note:  Changes in the project schedule are not visible in the Project Center or on team members' Task 

view until they have been Published to Project Server.  

7. To close the project plan, select the Project tab in the ribbon and click the Close button.  The 

Close window appears. Select Yes to check in the project plan. 
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3 
Managing Resources 

Understanding resources and their availability to work on projects is important to a project manager. 

This chapter describes how to use the Resource Center page in Project Web App to assist you in 

such tasks as viewing resource availability, viewing resource assignments, adding a resource in PWA, 

filtering for resources, and exporting Resource Center data to a spreadsheet in Microsoft Excel 2010. 

Overview of the Resource Center 
You can use the Resource Center in Project Web App to view, modify, and analyze information for 

one or more resources who are assigned to tasks in projects that are published to the Project Server 

database. Assignment information in the Resource Center tells you who is doing what in which 

project. The Resource Center displays a list of the resources in the Enterprise Resource Pool; 

permission to view items in the Resource Center is granted by the Project Server administrator. 

The following table lists the Microsoft Project Server 2010 permissions that are required in order for 

Microsoft Project Professional 2010 and Microsoft Project Web App users to work with the 

Resource Center. 

Permission 

type 

Permission Description 

Category View Enterprise 

Resource Data 

Allows a user to view resources and resource data that is 

stored in the Enterprise Resource Pool, including the Build 

Team, Resource Center 

Category Edit Enterprise 

Resource Data 

Allows editing and saving of resources in the Enterprise 

Resource Pool using Project Professional 2010 (optional) 

Category View Resource 

Assignments in 

Assignment Views 

Allows a user to view assignment details using Assignment 

view in the Resource Center 

Category  Approve Timesheets Allows a user to accept, but not approve, a timesheet (only 

needed if using Timesheets) 

Global View Resource 

Center 

Allows users to access the Resource Center from Project 

Web App or Project Professional and view resource 

allocation data 

Global View Assignments 

View 

Allows a user to view resource assignments in the Resource 

Center 

Global View Resource 

Availability 

Allows a user to access the View Resource Availability page 

to view resource allocation data in Project Web App 
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The Resource Center ribbon 
The Resource Center provides insight into enterprise resource information.  The Resource Center 

ribbon provides visibility into resource information, assignments and availability. 

 
 

You can do the following in the Resource Center: 

 Modify information about resources. Some resource attributes, such as calendar settings, can 

only be changed by using Microsoft Project Professional 2010. 

 View and analyze resource information, such as the availability of resources and their allocation 

across projects. 

 Analyze project performance by exporting data to Microsoft Excel 2010. 

 View resource assignments at the task and project level, and by availability. Project managers and 

resource managers can access this view; each group sees information that is specific to their 

needs. By default, a project manager can only use the View resource assignments option; what 

a project manager can view is determined by Project Server security categories and security 

groups, and the projects that they are associated with. (A user in the default Project Manager role 

in Project Server 2010 is not granted the Edit Enterprise Resource Data permission and 

therefore cannot edit or save information related to resources in the Enterprise Resource Pool.) 

 View and approve resource timesheets. Approving timesheets is useful for organizations that 

have multiple departments, such as payroll departments and project management departments, 

which require that timesheet approval be a separate process from updating task and project 

status by using timesheets. 

 Adjust actual work values on resource assignments that were submitted by team members. If 

your organization uses the managed timesheets feature of Project Server 2010, users who are 

assigned the appropriate permission can update or modify actual work entered by team members 

in their timesheets and locked-down timesheet reporting periods. 

 

Using the Filter drop-down and Group By features in the Resource Center 
You can use the Filter and Group By drop-down lists to customize how you want to sort and group 

resources. The Filter and Group By features are useful when the Resource Center includes a large 

number of resources. This feature includes the following options: 

 Filter: Allows you to filter resources by using a custom filter. You can use a custom filter by 

selecting Custom filter from the Filter drop-down list and then completing the More Filters 

dialog box. 
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 Group: Allows you to group resources by specified values. In the Group By drop-down list, 

either select a single grouping from the available list, which is all of the columns active in the 

view, or create a custom grouping parameter in the Group by drop-down list.  When you create 

a custom grouping, it is possible to set additional grouping parameter from the Then by drop-

down list. The second parameter filters data within the data filtered by first parameter.  To 

remove grouping, select the No Group option in the Group By drop-down list. 

 
 

 

Resource types 
When you use the Resource Center page in PWA, it is important to understand that there are three 

different types of resources for projects: 

 Work: A Work resource is anyone or anything that works on a task in your project. 
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 Material: Material resources are things that are kept on hand and used up by the tasks in a 

project. 

 Cost: A Cost resource is a cost with no time or quantity associated with it. 

 

Viewing resource assignments 
You can view current resource assignments by using the Resource Assignments page in the Resource 

Center in Project Web App. Resource assignments are displayed in a timesheet that shows the data 

for the current assignments that fall within the range specified for the view or are displayed in a 

Gantt Chart view.  

This view is similar to the Task Usage view in Microsoft Project Professional 2010. Assignments are 

displayed in a grouped structure of tasks within projects within resources, including generic and 

specific resources. (Only resources that are members of the Enterprise Resource Pool are available.) 

Tasks are sorted by Task ID within each project. Only resource assignments in projects that the user 

has permission to view are available. 

To view assignments for a resource:  

1. In the Resource Center in Project Web App, select the resources whose assignments you wish 

to view on the Resource Assignments page, you can elect to view the resource information in a 

Gantt chart view or a Time-phased Data view. 

 

2. Below is an example Gantt chart view of the assignments for the selected resources.  A table 

appears showing resource assignments and other information about the assignments. By 

selecting the check box, you have the ability to view Work hours, Overtime Work, Summary 

Tasks, and time with date.  Additionally, you can modify the date range showing by using the Set 

Date Range button. 
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An example of a Time-phased view of the assignments for the resources selected is shown 

below. 

 

3. On the Resource Assignments page, in the View drop-down list, select the view that shows 

the resource information that you want to review. 

View resource availability 
You can easily view availability information of specific resources on the Resource Availability page. 

To view availability of a resource: 

1. In the Resource Center in Project Web App, select the resources whose availability you wish to 

view, and then click the Resource Availability button.   

2. You can check and uncheck the resources selected in the left list.  This will adjust the numbers 

used to create the graph.  This view provides a graphical representation of resource information 

that will help you assess whether a resource is available for work during the period chosen in the 

Date Range. Various views exist that will help you determine the resource’s availability, including 

Assignment Work by project, Remaining Availability, and Work.  The resource availability 

Details are represented in tabular form on the lower portion of the page. 
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You can edit the details of enterprise resources by selecting the resource and then clicking the Open 

button.  Note that this opens Project Professional 2010, which is required for editing the resource.  

Note:  Only users with who are assigned the Edit Enterprise Resource Data permission and who have Project 

Professional 2010 installed on their local computer can edit resources in Project Professional 2010. 

Create a new resource in PWA 
You can add a new resource by using the New Resources feature on the Resource Center page. 

To create a new resource through the Resource Center:  

1. In the Resource Center in Project Web App, select the New Resource button. 

2. Specify the necessary properties for your resource.  

3. In the Type section, complete the following: 

o Type: Choose whether you are creating a Work, Material, or Cost resource. 

o Budget: If the resource is a budget resource, select the Budget check box. 

o Generic: If the resource is generic, meaning that you will use it for planning and replace it 

with at least one named resource further in the planning process, select the Generic check 

box. 

4. In the Identification Information section, complete the following: 

o Resource can logon to Project Server: Select this check box if you want the resource to 

also be a Microsoft Project Web App user.  

o Display Name: Type the resource's name in this box. This field is required. 

o E-mail address: If this resource has an e-mail address that he or she wants associated with 

project work, type the address in this box. 

o RBS: If your organization uses a resource breakdown structure (RBS), click the button next 

to this field and select the appropriate RBS code for this resource from the list. 
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o Initials: This field is automatically populated with the resource's initials, based on the name 

typed in the Display Name box. If you want to use different initials to refer to this resource, 

type them in the Initials box. 

o Hyperlink Name: If this resource has an associated Web site, type the name of that site in 

this box. 

o Hyperlink URL: If this resource has an associated Web site, type the URL to that site in 

this box. 

5. In the User Authentication section, complete the following: 

o User logon account: If you are using Integrated Windows authentication, type the user’s 

account name in the form of DomainName\UserAccountName. If you are using forms-

based authentication, type the user account name in the form of 

MembershipProviderName:UserAccount. 

o Prevent Active Directory Synchronization for this user: Select this check box to prevent 

a user account from being synchronized during Active Directory Resource Pool 

Synchronization. 

Note:  The User Authentication section only appears if the Resource Can Log on to Project Server 

option is enabled in the Identification Information section.  

6. In the Assignment Attributes section, complete the following: 

o Resource can be leveled: If you want to enable project managers to balance this resource's 

workload based on his or her availability and assignments (leveling), select this check box. 

o Base Calendar: Choose the calendar that most closely represents this resource's overall 

availability. For example, if your organization has a base calendar that accounts for specific 

holidays or events, you can set that as this resource's calendar, and work assigned to this 

resource will be scheduled around the calendar's nonworking days. 

o Default Booking Type: Choose whether you want this resource to be Committed or 

Proposed when assigning work. 

o Timesheet manager: Type the name of the person who approves or rejects this resource's 

timesheets, or click Browse to select the timesheet manager from a list. Resources may not 

have separate timesheet managers. 

o Default Assignment Owner: Type the name of the person who approves or rejects this 

resource's task progress, or click Browse to select the assignment owner from a list. 

Resources may not have separate assignment owners. For example, if the resource is a 

conference room, and the project manager tracks how long that the conference room is 

used, the assignment owner may be the project manager. 

Tip: You can set the assignment owner within the project on an assignment-by-assignment basis. 

o Earliest Available: Choose the date when the resource becomes available to assign to 
tasks, if it is appropriate. If the resource does not have a set period of availability (that is, if 
he or she is always available), leave this setting blank. 

Note: The earliest and latest available dates correspond to the resource availability dates for a 

resource, as seen in Microsoft Project Professional. 

o Latest Available: Choose the last date that the resource is available to work on 
tasks, if it is appropriate. If the resource does not have a set period of availability 
(that is, if he or she is always available), leave this blank. 

o Standard Rate: Type the resource's standard pay rate in this box. 

o Overtime Rate: Type the resource's overtime pay rate in this box. 
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o Current Max. Units (%): Specify the maximum time period that a resource is available for 

work, as a percentage. For example, if the resource is available full-time, type 100%. If the 

resource is available half-time, type 50%. 

o Cost/Use: If the resource has a flat fee associated with each use, type that cost in this box. 

For example, a van rental may require a flat fee up front, with an added standard cost per 

mile. The flat fee is its cost per use. 

7. In the Exchange Server Details section, you can specify whether the user’s tasks should be 

synchronized with Microsoft Exchange Server. Select the Synchronize Tasks check box if you 

want to enable task synchronization by using Microsoft Exchange Server for this user. Exchange 

integration must be configured for task synchronization to function. 

For more information about how to configure task integration with Microsoft Exchange Server, 

see Deploy Project Server 2010 with Exchange Server online in the TechNet library 

(http://technet.microsoft.com/en-us/library/ff793353.aspx).  

Note:  The Exchange Server Details section only appears if the Resource Can Log on to Project Server 

option is enabled in the Identification Information section.  

8. In the Departments section, click the button next to the Resource Departments box, and 

select which department or departments the resource is associated with. If the resource is not 

associated with a particular department, leave this setting blank. 

Tip: Associating a resource with a department narrows what the resource sees when they use Project 

Web App. It can help the resource find what he or she is looking for more quickly, by removing things 

from other departments that do not apply to his or her work. 

9. If your organization created codes for grouping and costing purposes, in the Group Fields 

section, complete the following: 

o Group: Type the name of the group in this box. 

o Code: Type the code for the group in this box. 

o Cost Center: Type the cost center code for the group in this box. 

o Cost Type: Click the button next to the Cost Type field, and then select the type of cost 

associated with this group. 

10. In the Team Details section, click the button next to the Team Name box, and select which 

team the resource belongs to, if it is appropriate. If the resource will be managing and delegating 

tasks that are assigned to the team, select the Team Assignment Pool check box. 

Tip: Some organizations create a generic resource for each team so that tasks assigned to the team 

first go to the generic resource. This way, no single resource takes on the task assignment before it is 

appropriately delegated. If you choose to use a generic resource in this manner, set the assignment 

owner for the resource as the team manager, select the Team Assignment Pool check box, and select 

the team from the Team Name list. 

11. In the System Identification Data section, type additional identifying information for the user 

in the External ID box, if it is appropriate. 

For example, your organization's HR department may use employee ID numbers to track data in 

its HR systems. By providing that ID number in the External ID box, you identify an 

association between the resource that you are creating and the HR department's employee data. 

The External ID box can also be used to facilitate the consolidation of reporting of resource 

use beyond what Project Server provides. 

Tip: If you are not sure whether you should be capturing any data in the External ID box, check with 

other departments in your organization to find out whether it would be useful to connect resource data 

with other systems, or merely leave this box blank. 

http://technet.microsoft.com/en-us/library/ff793353.aspx
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12. Once all the information is entered, select the Save button to create the new resource. 

Adding resources to a project plan 
In order to assign resources to tasks in the project, it is necessary to create a project team.  Enterprise 

resources can be added to a project team through both PWA and Project Professional using the 

Build Team from Enterprise feature. 

1. After publishing the project plan, select the Project tab, click the Build Team button. 

 

2. A large number of resources will be shown when Build Team opens.  To quickly locate the 

resources needed, apply a Custom Filter.  Select the Filter drop-down list and click Custom 

Filter.  Apply a filter, the example shown looks for Resource Names containing the value 

“Scott”.    

 
 

 

3. When the filter is applied, select the resource that you want and click the Add button.  The 

resource name will be added to the project team list in the right column.  Click the Save & 

Close button to save the changes and return to Edit mode in Project Center. 
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4. In the Project Center edit mode, assign resources to tasks, and update task level custom field 

information and setup duration and start date.  Note that it is now possible in PWA to assign 

multiple resources to a single task. However, the unit assignment for the resources is 100% on 

the task. 

 
 

Note:  After you modify duration, percent complete, and start or finish dates, and you link/unlink tasks, 

you must click the Calculate button for many of the changes to be reflected. 

5. Set up tasks and create project logic by establishing dependencies, insert new tasks, delete tasks, 

mark percent complete on tasks, and change the indentation level on tasks by using the icons in 

the Task ribbon. These features behave the same in PWA as in Project Professional. 

 

6. After you have set up tasks and created scheduling logic, select the Calculate button to make 

sure that all changes are reflected in the task data.  Once the project plan is set up, select the 

Save button and then the Publish button.   
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Note:  Changes in the project schedule are not visible in the Project Center or on team members' Task 

view until they have been Published to the Project Server.  

7. To close the project plan, select the Project tab in the ribbon and click the Close button.  The 

Close window appears. Select Yes to check in the project plan. 

 

Exporting Resource Center data to Excel 2010 
You can export Resource Center data to Microsoft Excel 2010 from Project Web App by using the 

Export to Microsoft Excel feature. Project Web App also enables you to copy data that is displayed 

in the Project Web App Grid Control and paste it into applications such as Microsoft Excel, 

Microsoft Word, and Microsoft Outlook. 

1. In the Resource Center in Project Web App, click the Export to Excel button. 

 

2. A file download window appears, allowing you to open or save the document. Select Open. 

3. If the window shown below appears, select Yes. 

 

4. The Resource Center view opens in Excel. 
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5. Click Save As on the File menu in Excel if you want to save the data as it is currently presented. 

You can save the data in any supported Excel format. 

 

 

 
  



   

45 
 

4 
Managing task updates 

This chapter describes how team members can update their tasks and then submit them for approval 

through Project Web App (PWA).  It also describes how project managers review task updates that 

are submitted for approval. 

 

Submitting task updates 
Team members can report time against published assignments (Project Tasks) through the PWA 

Tasks page.  As the project manager, you can also update actual work directly in Project Professional, 

but this should be done as the exception, not the rule, if you are accepting updates from PWA. 

The following scenario outlines the interchange between a team member and a project manager 

during the task update and approval process.  

1. A team member logs on to Project Web App.  On the PWA home page, the team member can 

click Tasks in the Quick Launch to view tasks that are assigned to him or her.  

2. Tasks that are assigned to the user appear on the Tasks page, as seen in the following image.  On 

the Tasks page, the team member can enter the actual hours worked in the grid based on the 

days he or she worked.   

Note:  Hours can only be entered on detailed tasks.  It is not possible to enter time against the project 

summary task.   
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3. The team member can use the buttons in the Period column of the ribbon to navigate to a 

previous week or later week by selecting the buttons.  The team member can also select a specific 

time period by clicking the Select Period button. 

 

The following image shows the Tasks page with actual hours updated by the team member.  

Note that the status bar for the page reads, “There are unsaved updates.”   

 

The following image shows a task’s Process Status on the Tasks page.  The current status of each 

task is listed in the Process Status column. If the Process Status for a task is highlighted, it is 

calling attention to an update for that task.  
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4. Subsequent to associating actual hours with a task assignment, the following steps have to be 

addressed, depending on whether the task is now complete. The team member can save updates, 

but not send them to the project manager, by clicking Save.  Updates can be sent at a later time 

by selecting one of the Send Status options.  

o If the task is complete, the user should make sure Remaining Work is 0, and the system will 

indicate 100% complete.  If the task indicates that there is work remaining but in fact the 

task is completed, the value should be changed to zero. 

o If the task is not finished with the task, the team member should update the Remaining Work 

with the hours expected to complete the task.  This may be more or less than the hours 

shown, which was calculated based on the original task work estimate and the hours that 

have been entered so far. The act of entering Remaining Work hours will recalculate the “% 

Complete” and “Work” values. 

In our scenario, the team member requests additional work hours to complete a task, 

specifically 60 hours instead of the 40 hours that was an automatically calculated value.  Ten 

of these hours have already been worked. Additionally, the team member attaches a 

comment to the update submittal. This process enables the team member to communicate 

to the project manager the reason why additional time is needed to complete the task.  

Note that the team member has selected only the one task to update. (Alternately, additional 

assignments can be updated by selecting them with a checked box or by clicking the Send 

Status >All Tasks button.) Also note that the Send Comment box is checked before the 

user clicks Send Status > Selected Tasks. The following image depicts task updates ready 

to be submitted. 
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When a team member is ready to submit a task update to the project manager, she or he 

selects the check box of the row for the status update.  He or she then clicks Send Status to 

view the following options: 

 All Tasks: Quickly send an update for all tasks updated to the Project Manager  

 Selected Tasks: Enables submitting updates for specific tasks at a time to the 

Project Manager 

 
Clicking Selected Tasks submit a status update for the selected task. 

5. When the Send Status > Selected Tasks button is clicked, the following comment box appears 

to receive the comment associated with the assignment update.  
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After the assignment update is submitted, the Process Status column reflects the current status 

of the task.  

 

Task viewing options 
Team members can select different task viewing options to change the way task information is 

displayed to them on the task page.  These options can be selected on the PWA ribbon. 

 

The following task viewing options are available on the PWA ribbon: 

 Import: Imports status data from the timesheet. 

 Layout: Allows for the following viewing options: 
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o Gantt Chart: Displays the data in Gantt chart view. 
o Timephased Data: Displays the data by the day, week, or other incremental time level. If 

this option is not selected, the date column grid does not appear for time entry. 
o Sheet: Displays the data in a table format. 

 Units: Allows the following viewing options for Duration, Work, and Date information. 

o Duration 

 Minutes 

 Hours 

 Days 

 Weeks 

o Work 

 Minutes 

 Hours 

 Days 

 Weeks 

o Date 

 1/28/2010 

 12:33 PM 

 1/28/2010 12:33 PM 

 Thursday, January 28, 2010 

 Thursday, January 28, 2010 12:33 PM 

 Thu 1/28 

 January 28 

 January, 2010 

 Filter: Changes the task information displayed to utilize a standard filter or create a custom filter. 

 

Task update approval 
After a team member has submitted an update, you as the project manager can then review the 

submittal and make a determination to accept it into the project schedule or reject it. 

The image below shows a project manager’s home page in PWA and the pending approval. Clicking 

the pending approval opens the Approval Center. 
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On the Approval Center page, you can view all submitted tasks updates that are pending your 

approval. Details about the task update — such as the resource who submitted the update or 

comments — are displayed on this page.  Clicking a task on this page displays additional task details 

about the update, as shown in the image below. 

 

You can then accept or reject the task update by selecting the check box next to the task, and then 

clicking the Accept or Reject button on the ribbon.  With either choice, you can optionally submit a 

comment back to the resource about the task update.  In the image below, the project manager has 

determined that the assignment update should be incorporated into the project schedule and notifies 

the team member by using a comment. 
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Processing task changes and requests 
The Approval Center page in Microsoft Project Web App enables you to review changes to project 

tasks and working times that team members submit by using the Tasks and Timesheet pages. You 

can use the Approval Center in Project Web App to review changes to project tasks and resource 

working times, and to update projects with the latest information. 

The following types of changes appear in the Approval Center in Project Web App: 

 Task changes 

 New task requests 

 Task delegation requests 

 Resource declined assignments 

 Resource declined task delegation requests 
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You can update project information based on the task changes that appear in the Approval Center in 

the following ways: 

 Manually   You can update projects for each task change that a team member submits by 

clicking Accept on the Approvals tab in the Approval Center. If you don’t want to approve a 

task change request, you can click Reject, and provide a comment to the resource submitting the 

request to give an explanation of the rejection. When you reject a change request, it is removed 

from the list in the Approval Center until the team member resubmits the request. 

 Automatically (by using rules)   You can create and run rules to automatically update projects 

with changes that do not need to be reviewed before approval. You can create rules that run for 

specific projects, for all projects, for specific resources, or for groups of resources at a specific 

location in the Resource Breakdown Structure of your organization. Even if you enable rules for 

automatic approval, you will need to publish the project before tasks will be fully rescheduled. 

The following table lists the Microsoft Project Server 2010 permissions that are required in order for 

Microsoft Project Professional 2010 and Microsoft Project Web App users to work with task 

updates. 

 
Global Permission Description 

Manage Rules Allows a user to access the Updates page 

in Project Web App and create rules that 

determine how update transactions are 

automatically processed. 

Manage 

Task 

Changes 

Allows users to access the Updates page in 

Project Web App to get task updates, and 

view, accept, or reject a resource’s 

transactions. 

 

Processing Task Changes from the Approval Center 
Project team members use the timesheet that is available in Project Web App to report changes to 

their assignments. Project managers automatically receive a notification when changes are submitted 

by team members assigned to tasks in projects that they manage. Project managers can choose to 

accept or reject each task change. 

Changes submitted by team members do not affect projects until they are published; only approved 

task changes are applied to projects that are published to the Project Server database and only 

approved task updates appear in projects as reported actual work. If you know that team members 

have changed tasks, added new tasks, delegated tasks, or declined tasks, but the submitted changes 

are not available in the Approval Center, your team members might not have actually submitted their 

changes. 

Before you accept or reject task changes from project team members, it is important to be aware of 

your organization’s timesheet processing cycle. For example, if your organization has a weekly 

timesheet cycle, you should plan to process all timesheet and task changes at least once per week, 

after all team members submit their status, but before the end of the weekly timesheet cycle. This 

helps to ensure that the correct data is submitted and accepted/rejected and also helps to prevent the 

publication of incorrect data as a result of updates.  

The Updates page has the following characteristics: 
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 If a team member sends multiple changes for a single task element, only the change that was 

submitted most recently is displayed. 

 If a team member delegates a task, one row is displayed in the update list. If the team member to 

whom the task was delegated rejects the delegation, the rejection appears as a separate row and 

the Accept field cannot be edited. 

 The tracking mode of the pending update determines whether to display a timesheet or a Gantt 

Chart view. If specific hours are used for any update, the timesheet is displayed. A Gantt Chart 

view is displayed for all other updates. 

 If an update is rejected, the team member who sent the update is notified by e-mail and an icon 

is displayed in their timesheet. 

 After a task change is approved, a record of the change is added to the History page. Any 

changes that were not approved or rejected are pending and remain in the Approval Center until 

they are accepted or rejected and processed. 

Approve or Reject Task Changes Submitted by Project Team Members 

1. On the Quick Launch, under Projects, click Approval Center.  

2. Select the check box in the left column for the task update row that you want to accept or reject. 

3. On the Approvals tab of the ribbon, click Accept or Reject. 

  

Note:  If you accept a task delegation request and update a project, you cannot reject the task 

delegation later. 

Viewing Task Change History 

You can view a history of all task changes that were processed within the previous 60 days. This 

history is for review purposes only; it cannot be modified. This enables you to review the history of 

updates made for all projects and resources. The update archive displays the updated tasks in a 

similar format to the Update task changes page. The Customization tabs display the same options 

that the Updates page displays. The Show Task Changes button in the action menu re-directs you to 

the Update task changes page. The number of days that are available in the task update history 

section is set by the Project Server administrator. 

Note:  Task changes appear in the grid, after you have processed (either accepted or rejected) them. To 

navigate quickly to the page where you can process task updates from team members, click Show Task 

Changes. If you want to adjust actuals for resources, go to the Resources page, and click Adjust Actuals. 
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1. In the Approval Center in Project Web App, on the Approvals tab, click History.  From the 

menu, click Status Updates or Timesheets.to view history on task updates for either.. 

 

2. Task updates made within the previous 60 days appear, presented in a grid format. In the task 

updates history, scroll to the right to view details about each update. Details include whether or 

not the task was accepted, current status, the Project Web App user to whom the task is 

assigned, the user who approved or rejected the task, and the actual work associated with the 

task, and other information about the task. 
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5 
Managing issues, risks, and documents 

The beauty of the EPM solution is the collaboration capabilities that are native to the product 

because of the components that have been incorporated into the solution mix. This function is 

greatly enhanced by the use of Microsoft SharePoint Foundation as the framework from which team 

collaboration can be better managed. 

Project artifacts such as Risks, Issues, and documentation can be stored, linked and attached to 

projects, and/or tasks. A project site (subsite) is automatically created for a project when a project 

plan is published in the Microsoft Project Professional environment.  Each subsite is created with its 

own library so that risks, issues and documents can be linked. 

When you use Microsoft® Project Server 2010, the following collaboration features are enabled:  

 Risks: Risk management involves proactively identifying and tracking events and conditions that 

have the potential to affect future planning for a project. Risks can be rated by severity and 

assigned an estimate for how likely they are to occur.  

 Issues: Issues can be used to track work items that are not easily identified as assignments or 

tasks within projects. Project managers, resource managers, and team leads can then determine 

whether the issues will have an effect on the project and identify strategies to manage the issues 

before they become larger problems.  

 Documents: A document library provides a location for team members to collaborate and share 

documents and other project artifacts with project team members. 

 Project Site: A project site can exist for each project saved to the Project Server database. The 

project site enables additional collaboration features (for example, announcements, alerts, 

deliverables and the ability to link these to your project tasks) by providing a Web site for each 

project that makes the capabilities of SharePoint Foundation available to a project team.  

As a project manager, it is important to know how to understand and manage the collaboration 

capabilities of project sites that you manage. 

Project risks 
Risks are events or conditions that can have a positive or negative effect on the outcome of a project; 

in many ways, managing risks is critical to the success of managing projects. Risk management 

involves proactively identifying and tracking events and conditions that have the potential to affect 

future planning for a project. Identifying risks is different than tracking issues because it involves 

identifying an event or condition that can affect the outcome of a project as opposed to tracking an 

actual effect on the outcome of a project. Risks can exist in the present time and can have up to a 

100 percent probability of occurring. Risks can also exist in the far future and have up to a 100 

percent probability that they will eventually be a factor in the lifecycle of a project.  
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Project risks can be submitted and tracked on the project site.  This allows greater communication 

between team members and provides a central repository for concerns.  Risks can be accessed 

through Microsoft Project Web App (PWA). 

 

Adding project risks 
Use the following procedure to add a project risk through PWA. 

To add a project risk:  

1. From the Project Center, select the project and the Project Site button, and click the project 

that will store the risk information. 

2. When the project site opens, click the Risks option on the Quick Launch bar. 

3. When the Risks page opens, click Add New Item. 

4. Enter the Risk information on the Risk Template (this template can be modified by the system 

administrator). 

 

5. You can Attach a file to this risk, or Link Items to this risk by selecting the associated button 

in the Risk ribbon. 
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Viewing and managing risks 
Use the following procedure to view project risks that are assigned to you.  When viewing the risk, 

you have options to make changes to the risk, such as adding an item, deleting, or managing 

permissions. 

To view the risks assigned to you: 

1. From the PWA Quick Launch bar, click Issues and Risks. 

 

2. Click the Project name with the risk that you wish to open. 

3. From the project site Risks page, choose the risk you wish to view or modify. 

4. You can Add a new item, Edit the risk, Delete the risk, Manage Permissions on this form, or 

set an alert by using the SharePoint Foundation notification mechanisms, if enabled.  

Project issues 
Issues tracking can be an integral part of project management. Issues are best used to capture work items that 

are not easily identified in assignments or tasks within projects. Team members and project managers can use 

the Issues page in the project site. Project managers, resource managers, and team leads can then determine 

whether the issues will have an effect on the project, and they can identify strategies to manage the issues 

before the problems become larger. 

Adding project issues 
Use the following procedure to add a project issue through PWA: 

To add a project issue:  

1. From the Project Center, select the project and the Project Site button, and then click the 

project that will store the issues information. 
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2. When the project workspace opens, click the Issues option on the Quick Launch bar. 

3. When the Issues page opens, click Add new item. 

4. Enter the Issue information on the Issue Template (this template can be modified by the system 

administrator). 

5. As with Risks, you can Attach a file to this risk, or Link Items to this issue by choosing one of 

the buttons on the Issues ribbon. 

  

Viewing and managing issues 
Use the following procedure to view issues that are assigned to you.  On the issue details page, you 

have options to add items to the issue, delete the issue, and manage permissions for the issue. 

To view the issues assigned to you: 

1. From the PWA Home Page, click Issues and Risks.  

 

2. Click the Project Issue that you wish to open. 

3. From the Issues page, choose the issue you wish to view or modify. 

4. You can Add a New Item, Edit the issue, Delete the issue, Manage Permissions on this 

form, or set an alert by using the SharePoint Foundation notification mechanisms, if enabled. 

Project documents 
Project Server 2010 integrates document management into the overall project management process 

by incorporating the SharePoint document library feature. A document library can be associated with 

any project that is published to the Project Server database, and it can provide a location for team 

members to collaborate and share documents (including Microsoft Word, Microsoft Excel, and many 

other document types and formats) outside of a project. In addition to document libraries, a public 

library can be used to store documents that are related to all projects in your organization. 
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You can access the document management feature of Project Server 2010 by clicking the Libraries 

link in Project Web App, by selecting Shared Documents, or by directly navigating to the project site 

from PWA. You can create document libraries for each project that is published to the project site. 

Documents are used to capture non-structured, project-related information that is not otherwise 

available in a typical project. 

 

Adding project documents 
Use the following procedure to add a document to a document library on a project site: 

To add a project document: 

1. From the Project Center, select the project for which you want to open the Project Site, and 

then click the Project Site button in the ribbon.  

 

2. When the project site opens, click the Project Documents option on the Quick Launch bar. 

 

The Project Document page opens. 

3. When the Project Documents page opens, click Add document to upload or import one or 

more files into the document list. You can also modify list settings and process with the proper 

permissions by clicking the Library tab, Library Settings. 
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4. From here you can View or Edit Properties, Manage Permissions, Edit or Delete the 

document, Send to using e-mail if it enabled, Check Out (a function of SharePoint Services that 

manages version control), or set an alert (for any revisions to a document).  
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6 
Managing status reports 

Status reports provide a simple method for communicating descriptive information about the status 

of specific tasks or an entire project. Status reports are narrative descriptions of the status of or 

progress on assigned tasks, and they enable you to automate the process of requesting and receiving 

status information. Project managers can send team members status report requests and team 

members can then respond to them by providing the information requested. Team members can also 

initiate the submission of status reports. Project managers can configure status reports so that they 

receive individual submissions and a merged or compiled status report that consolidates responses 

into a single status request. You can manage status reports, including status report requests, from the 

Project Web App Status Reports page. 

The Status Reports feature in Project Web App enables project stakeholders to send status reports to 

any persons involved with a project (as long as they are also Project Web App users) to provide 

information about the status of their tasks. When you are configuring status reports, you can do the 

following: 

 Specify the title of a status report and the frequency at which it must be submitted. 

 Identify the team members who will receive and respond to the status report request. 

 Specify the information that team members will report. 

 Send the request. 

Note:  Status reports are different than resource updates to task assignments. Use the Approval Center page 

in Project Web App to review updates to project tasks, to work with resource working times, and to update 

projects with the latest information.  

The following table lists the Microsoft Project Server 2010 permissions that are required in order for 

Microsoft Project Professional 2010 and Microsoft Project Web App (PWA) users to work with 

status reports. 

 
Global permission Description 

Edit Status Report Requests Allows a user to access the Request link in Project Web App. 

Edit Status Report 

Responses 

Allows a user to access the Responses link in Project Web App. 

Status reports are typically submitted on a scheduled, recurring basis. For example, a project manager 

might want to receive a weekly status report from each team member assigned to tasks in a project. 

The default status report form includes headings such as Major Accomplishments, Objectives for 

the Next Period, and Hot Issues, but these can be customized to meet the status reporting needs 

of different organizations. 
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You can complete the following activities from the Status Reports page: 

 Requests   Allows project managers and project stakeholders to create a reporting template and 

sent out a status request to team members for reporting progress. You can create a new status 

report for your team, edit an existing status report request, delete a request, view individual 

responses, or consolidated responses to requests.  

 Responses   Allows team members to reply to a status report sent by their project manager or 

by any other Project Web App user. 

 Submit unrequested report   Allows any project stakeholder to return a status request or define 

and submit a status report to any other selected project stakeholders in Project Web App. Users 

can respond to upcoming status report requests or create and submit an unrequested status 

report.  

 Viewing an archive of submitted status reports   Allows you to view and edit sent and unsent 

status reports. 

For example, as a project manager you might need to create a weekly report that covers the overall 

progress of a project. By using the Requests feature, you can set up a status reporting template for 

team members that, when completed, provides information about important activities during a 

specified time period. You can configure status report requests to be sent out automatically at 

specified intervals to team members. Team members are then notified on their Project Web App 

Home page of the pending status report that requires a response. Project managers and team 

members can also use the Task Alerts and Task Reminders features to customize e-mail 

notifications and reminders. By using the Responses feature, team members can complete the status 

report and send the response back to the project manager. You can group responses, which allows 

you to verify the response rate for a status report request, and then you can merge completed status 

reports and view the consolidated responses from team members. 

Users must be granted the Edit Status Report Responses and/or Edit Status Report Requests 

Project Server permissions by the Project Server administrator in order to submit status reports, view 

status reports, submit unrequested status reports, and manage status report requests. By default, only 

members of the following Project Server security groups have the permissions required to request 

status reports and view group responses: Executives, Project Managers, and Resource Managers. Any 

Project Web App user can submit a status report, either in response to a status request or of their 

own initiative. 
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The following tips are helpful when you are creating status reports: 

 Include a department name or project name in the title for the status report. 

 Microsoft Project Server 2010 automatically generates the first status report at the start date 

specified in the setup pages for the status report, and generates status reports on the first day of 

each reporting period thereafter. 

Requesting and updating status reports 
You can request and update status reports by using the Status Reports page in Project Web App. 

Status reports are forms that team members use to provide specified information about the current 

status of their work. Unlike task updates, status reports are not associated with a project, do not 

contain information about a project (unless it is added to the text of the status report itself), and 

cannot be used to update a project schedule. Status reports can be used to provide detailed 

information about accomplishments, goals, issues, and other factors that affect a team member’s 

work. When you create a status report request, you must define the sections that it contains, who 

must respond to it, and how frequently it is sent out and replied to. 

When you request a status report, a notification appears on the user’s Home and Status Reports 

pages in Project Web App. The user can reply to the status report request by selecting that report on 

either page.  Team members can submit unrequested status reports on any topic in the Responses 

section by using the Submit Unrequested Report option. This displays a page from which a team 

member can create a status report and send it to the appropriate Project Web App user. 

Note:  Unrequested status reports are not recurring; they must be submitted individually and in addition to any 

required recurring status reports. 

To request a status report 

1. On the Project Web App home page, in the Quick Launch, in the Resources section, click 

Status Reports.   

2. On the Status Reports page, in the Requests section, click New, and then click New Request.  

 

3. In the Report Title section, in the Title box, enter the name of the new status report. 

 

4. In the Frequency section, specify the frequency in which the status report must be submitted 

and the day of the week, month, or year on which the status report is due. 
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5. In the Start Date section, in the Start box, specify the date to begin the period that the status 

report will cover. 

 

6. In the Resources section, in the Available Resources list, select the resources who should 

respond to the status report request. 

Click the Add button to add the resources to the Resources Who Should Respond list. 

 

The selected resources will appear in the Resources Who Should Respond list. 

 

7. To remove a resource from the Resources Who Should Respond list and return them to the 

Available Resources list, highlight the resources name, and then click the Remove button. 

 

8. To create the Status report sections, click the Insert Section button and indicate the topics that 

you want your resources to report by entering a title and brief description for each section of the 

status report. Three titles are listed by default: Major Accomplishments, Objectives for the Next 

Period, and Hot Issues. You can delete those rows, change the name and include a description.  

 

Complete the following: 
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 In the Name column, type the names of the status report sections, for example, 

“New Section for Information”. 

 In the Description column, provide any additional descriptive text that you want to 

provide, for example, “Please enter Additional information about the project”. 

 

 Click Insert Section to insert a row at the bottom of the list. 

 

 Click Delete Section to delete the currently selected row.  

 

9. To send the status report request to the selected team members, click the Send button. Use the 

Cancel button to exit the status report creation, recognizing that all previous work on this status 

report request will not be saved. 

 

The new status report will be available on the Status Reports page in the Requests section. 

 

 

 To edit a status report request 

1. On the Status Reports page in Project Web App, in the Requests section, select the row with the 

name of the status report you want to edit.  Click the Edit Request button. 
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The status report request page opens. Edit the report as necessary.  

2. When you are finished, click Send to send the status report to the individuals identified in the 

Resources Who Should Respond list. 

 

Viewing status reports 
You can view individual team member status report responses as a group status report as well as 

status reports that you did not request. You can use the Group merged reports by feature to view 

consolidated responses to a status report request by either resource name or response date.  A 

notification also appears on the Home page in Project Web App if you requested a status report. 

The View Responses button shows the individuals who have responded to the status report request, 

grouped by reporting period. Icons indicate whether a report was submitted, and whether it was 

merged into a consolidated report. 

Miscellaneous reports are created when unrequested status reports are submitted or when a non-

project team member was copied on a requested status report. You can access these through the 

Status Reports page in the Responses section, selecting Status Report: Miscellaneous from the 

Go To drop-down list.  

Responses can be exported to Word on the Status Report Responses page or Excel in the Requests 

section Action drop-down list on the Status Report page. 

 To view status report responses 

1. On the Status Reports page in Project Web App, click on the report name in the Requests 

section.  

2. In the View Responses page, highlight all the resource’s responses that you wish to view in a 

merged file, and then click the Open button.  

 

3. The Status Report Responses page shows the responses either merged or individually, depending 

on how you elected to view the information. Select the Export to Microsoft Word command to 

pull the responses out of PWA and into Word. 
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 To view the details for an individual Project Web App user, select the user and click 

Open. 

 

 To merge the details from an individual Project Web App user into a consolidated 

status report, select the user and click Merge. 

Note:  Pending status report responses are also listed on your Project Web App Home page 

immediately after you log in. 

Viewing the status report archive 
The Status Reports Archive contains all the status reports sent or received by the current user. This 

archive allows you to access these reports, view and update. This will allow text to be added to each 

topic section specifying any update to the original comments. Pressing the Send button resends the 

selected status report in the Status Reports Archive. 

Note: This feature is only available for status reports that have been sent, received, or saved. 

 To view the status report archive 

1. In the Status Report page in the Responses section, select Status Reports: Archive from the Go 

To drop-down list. 

 

2. To view a specific status report within the Status Reports Archive, click the report name in the 

Report column. After you select a report, you can: 

 Add more information to the status report. 

 Add a new section to the report 

The update view opens with a new section in which you can type updated status report 

information. To add an additional section to the updated status report, click the Click to add 

section button. Click Save to save the updated status report to the Status Reports Archive. Click 

Send to send the status report to the Project Web App user identified in the To field. 
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3. To return to the Status Report page, select Status Report link in the Resources section of the 

PWA left navigation column.  
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7 
Configuring e-mail notifications and 
reminders 

You can use e-mail notifications to be alerted to changes to, or actions required for, projects that you 

or resources that you manage belong to. You can use reminders to be alerted to upcoming or 

overdue actions that you or resources that you manage are responsible for. Alerts and reminders are 

triggered by specific events in Microsoft Project Server 2010, and they generate e-mail messages that 

are sent to the appropriate users’ e-mail accounts. The Manage My Alerts and Reminders and Manage My 

Resources’ Alerts and Reminders pages allow you to configure how you or resources that you manage are 

alerted to changes related to your tasks, status reports, or queue job failures. The notifications that 

you receive can provide hyperlinks to the appropriate pages in Microsoft Project Web App (PWA) 

from which the recipients of the notification or reminder can take further action. 

Note:  Manage My Alerts and Reminders is configured at the user level; each Project Web App user must 

subscribe and unsubscribe to their own notifications. In some cases, depending on security settings, a 

resource manager in Manage My Resources’ Alerts and Reminders can configure e-mail notifications and 

reminders for the resources they manage. 

The following table lists the Microsoft Project Server 2010 permissions that are required in order for 

Microsoft Project Professional 2010 and Microsoft Project Web App users to configure e-mail 

notifications. 

 
Global permissions Description 

Manage Notification and Reminders Allows a user to manage the Alerts and Reminders 

settings within Project Web App Server Settings. 

Manage Personal Notifications Allows a user to access the Manage My Alerts and 

Reminders link in the Personal Settings section of 

the Project Web App navigation column. 

Manage Resource Notifications Allows a user to access the Manage My Resources’ 

Alerts and Reminders link in the Personal Settings 

section of the Project Web App navigation column. 
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Overview of e-mail notifications and reminders 
Notifications are generated by a wide range of user-initiated events. These events can be the actions 

of other team members and project managers; for example, a project manager sending a new task to 

a resource can trigger a notification to the team member who is assigned to the task so that that 

person is aware of and can act upon the new assignment.  

The following user actions can generate e-mail notifications: 

 Publish  

 Reassigns Tasks 

 Task Updates 

 New Tasks 

 Overdue Tasks 

 Status Report Requests 

 Status Report Responses 

 Overdue Status Reports 

 New Issue is Opened 

 New Risk is Opened 

 Issue Assignment 

 Issue is Modified 

 Document Changes (New, Delete, Modify) 

 Task List Delegation 

 Queue Job Failure 

The following actions generate e-mail notifications by default (users cannot unsubscribe to these 

notifications): 

 Rejected Assignments (by Resource) 

 Rejected Task Updates (by Manager) 

 Rejected New Tasks (by Manager) 

 Rejected Calendar Updates (by Manager) 

 Rejected Reassign Task Requests (by Manager) 

 Rejected Remove Task (by Manager) 

 Removed from a Status Report (by Manager) 

Reminders are triggered by timed events. For example, if a task is due to be completed by a resource 

on a certain date, a reminder is sent to the resource indicating the current status of the task. Project 

Server 2010 checks for and submits reminders at an interval specified by the user or resource 

manager/project manager with rights to Manage My Resources’ Alerts and Reminders. 

Project Web App users can define when Project Server sends e-mail notifications or reminders to 

themselves. Project managers and resource managers can define e-mail notifications and reminders 

for themselves and for their team members. Team members cannot unsubscribe to e-mail 

notifications or reminders that are configured for them by their project manager or resource 

manager. 

The Project Web App Personal Settings section of the Project Web App navigation column includes 

the following links that you can use to configure e-mail notifications and reminders: 

 Manage My Alerts and Reminders   Use this link to configure e-mail notifications for changes 

to your tasks and status reports. Notifications for tasks and status reports are configured 

separately. 
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 Manage My Resources’ Alerts and Reminders   Use this link to configure e-mail notifications 

for changes to your resources’ tasks and status reports. 

As a project progresses, you might want to adjust the type and frequency of e-mail notifications and 

reminders. For example, you might initially set a longer reminder for overdue tasks, such as several 

days or several weeks, and then shorten it when you are closer to project completion so that the 

reminders are sent out as soon as a task becomes overdue. You also might want to unsubscribe to 

notifications. 

E-mail notifications and reminders for tasks, projects, resources, status reports, and updates are 

configured by the Project Server administrator. In addition, e-mail notifications and reminders can be 

customized. 

Configuring personal notifications and reminders 
All users of Project Web App can configure the types of e-mail notifications and reminders that they 

want to receive. 

Subscribe to personal e-mail notifications and alerts 
You can configure your own personal e-mail notifications and alerts by using the following 

procedure.  

 To subscribe to personal e-mail notifications and alerts 

1. On the Project Web App Home page, in the Quick Launch, click Personal Settings, and then 

select Manage My Alerts and Reminders 

Note:  The e-mail address to which alerts are sent is listed at the top of the Manage My Alerts and 

Reminders page next to E-mail address. 

2. To configure alerts for tasks, expand the Tasks section, and configure the following: 

 If you want to receive e-mail immediately upon the occurrence of specified events, 

in the Alert me immediately when section, select the appropriate check boxes to 

set e-mail alerts to be sent when you receive new task assignments or when your 

tasks are modified or updated. 

 

 If you want to receive e-mail at specified intervals, in the Task Reminders section, 

select the appropriate check boxes to set e-mail alerts to be sent before tasks start, 

before tasks are due (and overdue), for incomplete tasks, and for overdue tasks. For 

each interval, specify the frequency. 
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3. To configure alerts for status reports, expand Status Reports section, and configure the 

following: 

 If you want to receive e-mail immediately upon the occurrence of specified events, 

under the Alert me immediately when heading, select the I receive a new status 

report request check box to set e-mail alerts to be sent when you receive a new 

status report request. 

 

 If you want to receive e-mail at specified intervals, under Status Report 

Reminders, select the appropriate check boxes to set e-mail alerts to be sent when 

status reports are due, when your status reports are overdue, and when status 

reports are submitted or have become overdue. For each interval, specify the 

frequency. 

 

4. To receive alerts about queue job failures, expand the Queue Job Failure section, and configure 

the following: 

 

5. If Multilingual User Interface Packs (MUI Packs) are installed for Project Server 2010, select the 

language in which you want to receive your e-mails from the Language Settings drop-down 

list. 

 

6. Click Save. 
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Unsubscribe to personal e-mail notifications and alerts 
If you want to no longer receive personal e-mail notifications and alerts, use the following procedure. 

 To unsubscribe to personal e-mail notifications and alerts 

1. On the Project Web App Home page, in the Quick Launch, click Personal Settings, then select 

Manage My Alerts and Reminders. 

Note:  The e-mail address to which alerts are sent is listed on the Alert Me about My Tasks and Status 

Reports page next to E-mail Address. 

2. To unsubscribe to alerts for tasks, expand the Tasks section and clear the check box for the 

specific type of alert and reminder from which you want to unsubscribe. 

 

3. To unsubscribe to alerts for status reports, expand the Status Report section and clear the I 

receive a new status report request check box and all check boxes under the Status Report 

Reminders section. 

 

4. To unsubscribe to alerts for queue job failures, expand the Queue Job Failures section and 

clear the Any of my Queue Jobs fails check box. 
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5. Click Save. 

 

Configuring notifications and reminders for your resources 
Users of Project Web App who manage resources can configure e-mail notifications and reminders 

to be sent to their resources when specific actions occur. 

Subscribe your resources to alerts and e-mail notifications 
If you want to configure alerts and notification for resources that you manage, use the following 

procedure. 

 To configure e-mail notifications for your resources 

1. On the Project Web App Home page, in the navigation column, click Personal Settings, then 

select Manage My Resources’ Alerts and Reminders. 

Note:  The e-mail address to which alerts are sent is listed on the Manage My Resources’ Alerts and 

Reminders page next to E-mail address. 

2. To configure alerts for your tasks assigned to your resources, expand My Team Members’ 

Tasks, and configure the following: 

 If you want to receive e-mail immediately upon the occurrence of specified events, 

in the Task Alerts section, select the appropriate check boxes to set e-mail alerts to 

be sent when your team members submit new tasks and assignments, reassign tasks, 

and when team members update tasks. 

 

 If you want to receive e-mails at specified intervals for upcoming tasks, under Task 

Reminders, select the appropriate option to set e-mail reminders to be sent before 

tasks are due and have the alerts sent only to you, only to your team members, or 

both to you and your team members. You can also specify the number of days, 

weeks, or months in advance of the due date for the upcoming task that the e-mail 

is sent. 
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 If you want to receive e-mail alerts at specified intervals for overdue tasks, in the 

Task Reminders section, select the appropriate check boxes to set e-mail alerts to 

be sent when tasks are overdue (and again until the overdue task is completed) and 

select the appropriate option to set the alerts to be sent only to you, only to your 

team members, or both to you and your team members. You can also specify the 

number of days, weeks, or months past the due date for the overdue task at which 

the alert is sent and the frequency at which reminder e-mails are sent until the task is 

complete. 

 

 If you want to receive e-mail at specified intervals for tasks that have been in 

progress but have no actual work, in the Task Reminders section, select the 

appropriate options to set e-mail alerts to be sent when a task is started, but has no 

reported actual work, and have the alerts sent only to you, only to your team 

members, or both to you and your team members. You can also specify the number 

of days, weeks, or months after the task has started at which the alert is sent. 

 

3. To configure reminders for your resource’s status reports, expand My Resources’ Status 

Reports, Status Report Alerts, and configure the following: 

 If you want to receive e-mail immediately when your resources send a status report, 

in the Status Report Alerts section, select the check box to set e-mail alerts to be 

sent when your resources submit a status report. 

 

 If you want to receive e-mail at specified intervals for upcoming status reports, in 

the Status Report Reminders section, select the appropriate option setting e-mail 

alerts to be sent when a resource’s status report is due and have the alerts sent only 

to you, only to your resources, or both to you and your resources. You can also 
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specify the number of days, weeks, or months in advance of the due date for the 

status report at which the alert is sent. 

 

 If you want to receive e-mail at specified intervals for overdue status reports, in the 

Status Report Reminders section, select the appropriate options to set e-mail 

alerts to be sent when a resource’s status report is overdue (and until the status 

report has been sent) and have the alerts sent only to you, only to your team 

members, or both to you and your team members. You can also specify the number 

of days past the due date for the status report at which the alert is sent and the 

frequency at which reminder e-mails are sent until the status report is submitted. 

 

4. If Multilingual User Interface Packs (MUI Packs) are installed for Project Server 2010, select the 

language in which you want to receive your notifications from the Language Settings drop-

down list. 

 

5. Click Save. 

  

Unsubscribe your resources from e-mail notifications 
If your resources are currently configured to receive personal e-mail notification and alerts, use the 

following procedure to unsubscribe them.  

 To unsubscribe to personal e-mail notifications and alerts 

1. On the Project Web App Home page, in the navigation column, click Personal Settings, then 

select Manage My Resources’ Alerts and Reminders. 

2. To unsubscribe to alerts for your resource’s tasks, expand My Team Members’ Tasks and in 

the Task Alerts section clear the check box for the specific type of alert from which you want to 

unsubscribe. 
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3. To unsubscribe to e-mail notifications sent when your resources send status reports, expand My 

Resources’ Status Reports and in the Status Report Alerts section clear the Submit a status 

report check box. 

 

4. Click Save. 

  
 
 


